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Appendix D

D
Photoshop Menu by
Menu

Like most programs, Photoshop groups all its commands into menus. On a Mac,
Photoshop’s menus appear at the top of your screen in the OS X menu bar, and on
a PC they live in the Photoshop’s Application bar. Strap yourself in and hold on
tight for a warp-speed tour of Photoshop’s menus!

Photoshop
This menu, which appears only in the Mac version of Photoshop, includes items
like information about the program, preferences, and the Quit command.
NOTE

On a PC, you can find the items in this menu in the File, Edit, and Help menus instead.

About Photoshop
Select this item to see which version of Photoshop you’re running and to learn the
names of the folks who wrote the program.

About Plug-In
This option shows info about all the different plug-ins installed in Photoshop, both
the plug-ins that shipped with the program and any custom goodies you may have
added.

Preferences
You can check out Photoshop’s preference settings by choosing this option (see
page 28 in Chapter 1). On a PC, go to Edit ➝ Preferences instead.
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Services
Mac OS X includes a feature called Services that lets you do things like look up a
word in the dictionary, send a chunk of text as an email message, summarize a passage of text, and so on. Any Service installed on your Mac shows up here. Photoshop, alas, doesn’t support Mac OS X Services, so you can’t take advantage of them
when you’re editing your images.

Hide Photoshop
Hides all of Photoshop’s menus, panels, and windows so you can work in other
programs. (This is like minimizing the Photoshop window on a PC.) To show
Photoshop again, click its icon in the Mac OS X Dock or use the c-Tab keyboard
shortcut.

Hide Others
Hides every program your computer is running except Photoshop.

Show All
Reveals every program you may have hidden with the Hide command.

Quit Photoshop
Closes your open images and exits Photoshop. On a PC, you can quit Photoshop
by choosing File ➝ Exit.

File
The File menu is home to commands that let you open and close documents,
import and export files, browse files in Adobe Bridge, print documents, and so on.

New
Creates a new document (page 37 in Chapter 2).

Open
Lets you pick an existing document to open (page 47 in Chapter 2).

Browse in Bridge
Launches Adobe Bridge so you can look at images before you open them in Photoshop (see Appendix C).

Open As Smart Object
Lets you open a file as a linked Smart Object in a new document (page 50 in
Chapter 2).
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Open Recent
Displays a list of recently opened documents (page 50 in Chapter 2) so you can
reopen them easily without digging through your hard drive.

Share My Screen
Lets you share your computer’s screen and your work with other people through
Adobe’s ConnectNow service. You can try out ConnectNow at www.adobe.com/
acom/connectnow.

Device Central
Launches the Device Central CS4 program that comes with Photoshop CS4 (page 45
in Chapter 2).

Close
Closes the current document.

Close All
Closes every document you have open in Photoshop.

Close and Go To Bridge
This option closes the current document and opens Bridge so you can browse for
other images.

Save
Saves the current document to your hard drive (page 45 in Chapter 2). If you’ve
already saved the document, choosing this command overwrites the previous version. (You’ve been warned!) If you haven’t saved the document before, choosing
this command opens the Save As dialog box, explained next.

Save As
Opens the Save As dialog box where you can save a copy of the current file with a
new name or in a different file format (page 46 in Chapter 2).

Check In
If you’re using Version Cue (see the box on page 58 in Chapter 2) and have
checked out some images to edit them, this option lets you check them back in so
that other people using Version Cue can open them.

Save for Web & Devices
Lets you save a copy of the current document in formats that work well with Web
browsers and devices like smart phones (page 665 in Chapter 17).
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Revert
Wipes out any changes you’ve made to the current document and returns it to its
last saved state (page 28 in Chapter 1).

Place
Use this option to place an image or other Photoshop-supported file format as a
Smart Object inside your current document (page 117 in Chapter 3). The artwork
appears on its own layer, surrounded by a bounding box you can use for resizing.

Import
When you choose this menu item, Photoshop opens another menu containing
options for using a scanner to get a picture, drawing, or anything else off paper and
into Photoshop (see the box on page 52 in Chapter 2 for more on scanning). Make
sure you’ve installed your scanner software so Photoshop can communicate with
your scanner (if the software isn’t installed, you won’t see it in the submenu). Here
are the items in the Import submenu:
• Variable Data Sets let you import files that are filled with info Photoshop needs
to make customized images based on a template file.
• Video Frames to Layers lets you open a movie file’s frames as individual layers
in a new document.
• Anti-aliased PICT (Mac only) opens .pict images made with old programs like
MacDraw.
• PICT Resource (Mac only) opens a special kind of .pict image that stores its
information in a part of a file called the resource fork. This file type predates Mac
OS X by a long shot, so you probably won’t come across it very often.
• Notes lets you import annotations into your image from PDF documents.
• WIA Support (PC only) imports images from WIA-compatible, or Windows
Image Acquisition, digital cameras and scanners.

Export
Choose this menu item to export your image as paths (page 497 in Chapter 13) so
you can open them with Adobe Illustrator, export collected data (Photoshop CS4
Extended only), or export a sequence of images to video.

Automate
As you learned in Chapter 18, you can automate the tasks you do over and over in
Photoshop by saving them as actions. This menu item lists the built-in actions that
come with Photoshop.
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Scripts
Scripts go hand in hand with Automation because they can both handle repetitive
or complex tasks for you. Photoshop’s built-in scripts (like the super handy Image
Processor—see page 238 in Chapter 6) are listed here.

File Info
Choose this item to see info (aka metadata) about the current document, including
when the file was created, how big the image is, its name, copyright information,
and so on. You can add and edit these details, too.

Page Setup
Go here to choose your printer, paper size, page orientation, and so on before you
print your document; Chapter 16 discusses this dialog box in great detail (page 625
in Chapter 16).

Print
Selecting this item opens the humongous Print dialog box and lets you choose
things like the number of copies, print quality, and which printer you want to use
(see Chapter 16). After you get the settings just right, click Print to send your document to the printer.

Print One Copy
Choose this option to make Photoshop send the current document to the printer
you normally use without giving you a chance to change any settings first. Think of
Print One Copy as a quick-and-dirty way to print an image without encountering
a slew of dialog boxes.
NOTE

On PCs, the File menu also includes the Exit command.

Edit
In this menu you’ll find the Copy and Paste commands, Transform options (page
245 in Chapter 6), and keyboard and menu shortcut settings, among other items.
If you use a PC, you can also find Photoshop’s preferences here.

Undo
Make a mistake editing your image? Use this command to erase the last thing you
did to your image (see page 24 in Chapter 1).

Step Forward
If you backtrack through your image edits, you can move forward through them
again by choosing this command (page 24 in Chapter 1).
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Step Backward
Step Backward works just like Undo, but you can use it to go back more than one
step (see page 24 in Chapter 1).

Fade
This command lets you change the strength (opacity) and blend mode (page 267
in Chapter 7) of the last image edit you made. It works on filters, image adjustments, and so on. You can learn more about it on page 426 in Chapter 11.

Cut
Copies the selected item to your computer’s memory and deletes the original.

Copy
Copies the selected item to your computer’s memory but leaves the original intact.

Copy Merged
This command makes a merged copy of all the visible layers in a selected area. If
you’re editing a multi-layer document, this is a handy way to quickly consolidate
and copy a certain part of the image—the area you’ve selected—onto a single layer,
without having to select that area on each individual layer.

Paste
Places objects you’ve copied to your computer’s memory into the current document.

Paste Into
This command lets you paste one selection into another. For example, if you copy
a selection and then create a selection in another document, you can use this command to make Photoshop paste the contents of that first selection into the second
one, complete with a layer mask.

Clear
The Clear command deletes whatever you’ve selected from the active layer.

Check Spelling
If you add text to your image, this command checks for spelling errors (see the box
on page 553 in Chapter 14).

Find and Replace Text
This command lets you find specific words or phrases in your document and
replace them with different text if you like.
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Fill
This command fills the selected area with the color of your choosing. If you
haven’t selected anything, it fills the whole layer instead.

Stroke
This command adds a colored stroke, or outline, to your current selection.

Content-Aware Scale
The Content-Aware Scaling feature lets you change the size of an image without
distorting the important parts, like people—see page 242 in Chapter 6.

Free Transform
This command lets you scale, stretch, warp, distort, and rotate the selected object
(see page 245 in Chapter 6).

Transform
Transform works like Free Transform but lets you change only one aspect of the
selected object at a time. For example, you can rotate the object, but you can’t scale
it at the same time. See page 245 in Chapter 6 for more info.
NOTE The Free Transform and Transform features work on individual layers (as many as
you’ve selected), not on your entire document.

Auto-Align Layers
This command makes it easy to create panoramas from a group of similar images.
When you run this command, Photoshop looks for the common elements in each
photo and aligns them automatically (see page 283 in Chapter 7).

Auto-Blend Layers
This option lets you combine the best parts of similar images into a single image;
Photoshop creates all the necessary layer masks for you. Page 288 in Chapter 7 has
the details.

Define Brush Preset
Choose this option to convert the selected object into a custom brush (page 488 in
Chapter 12).

Define Pattern
This item makes a custom pattern out of your current selection (page 512 in
Chapter 13).
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Define Custom Shape
This option turns the selected path or vector mask into a custom shape (page 494
in Chapter 13).

Purge
This item lets you clear Photoshop’s undo list, the items you’ve copied to your
computer’s memory, or the edits Photoshop is remembering as history states. You
can also choose to clear all three at once.

Adobe PDF Presets
This item lets you manage, edit, and add groups of settings you can use when you
make PDF versions of your images. You can learn more about the PDF format in
Chapter 16.

Preset Manager
You can manage groups of custom brushes, patterns, shapes, colors, and styles by
selecting this menu item, which lets you edit or combine groups into new libraries
and delete groups. Chapter 2 has the scoop on using the Preset Manager.

Color Settings
This item brings up Photoshop’s advanced color settings so you can control color
management and device profiles (see Chapter 16).

Assign Profile
This option is part of Photoshop’s color-management system. From here, you can
assign specific color profiles to individual documents or disable color management (see Chapter 16).

Convert to Profile
This option lets you change your image’s color-management profile (see Chapter
16).

Keyboard Shortcuts
Choose this item to customize Photoshop’s keyboard shortcuts, add your own, and
save your personalized menu commands to share with other folks (see the box on
page 31 in Chapter 1).

Menus
Choose this option to see all of Photoshop’s menus and tweak them if you like (see
the box on page 31 in Chapter 1).
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NOTE In the Windows version of Photoshop CS4, the Preferences option appears at the bottom of the Edit menu.

Image
The Image menu groups together features for working with images and your canvas.
You can resize documents, adjust Curves and Levels, duplicate images, and rotate
images from here.

Mode
This is where you change the current document’s color mode (page 40 in Chapter 2)
and bit depth (page 43 in Chapter 2). You can choose from Bitmap, Grayscale,
Duotone, Indexed Color, RGB, CMYK, Lab, and Multichannel color modes (see
Chapters 5 and 16) and 8-, 16-, and 32-bit images (see the box on page 43 in
Chapter 2).

Adjustments
From here you can change the colors and overall tonal quality of your image.
Chapter 9 has more info.

Auto Tone
This command analyzes the current image and tries to adjust its overall colors to
make it look better. Flip to Chapter 9 if you want to learn more about fixing color
in your images.

Auto Contrast
This command adjusts the contrast between light and dark areas in your images so
that highlights look brighter and shadows look darker. Check out Chapter 9 to
learn more.

Auto Color
Artificial lighting can skew the colors in your images, so use this command to shift
them back so your image looks more natural. Chapter 9 has the skinny on adjusting colors.

Image Size
This option lets you change your image’s resolution and dimensions. This dialog
box is discussed at length in Chapter 6.
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Canvas Size
Choose this option to change your document’s dimensions without changing its
file size or resolution. Use this option if you need more space in your document
but don’t want to resize the elements that are already there.

Image Rotation
Use this item’s options to rotate your image and canvas. You can choose one of the
presets like 180˚ or “90˚ clockwise” or choose Arbitrary and enter the number of
degrees you want to rotate your image.

Crop
This command saves the area you’ve selected and deletes everything else, leaving
you with an image that’s only as big as the area you selected. See Chapter 6 for
more on cropping.

Trim
Like Crop, this command lets you cut an image down to size, but it doesn’t delete
the areas outside the remaining image (see page 215 in Chapter 6).

Reveal All
This command shows you all the hidden elements in your image (page 207 in
Chapter 6).

Duplicate
This command makes a copy of your current document and lets you give the
duplicated document a new name.

Apply Image
The Apply Image command lets you combine a layer and channel from one document with a layer and channel from another document using the blend mode and
opacity of your choice (see page 281 in Chapter 7).

Calculations
This command works a lot like Apply Image, but instead of combining layers and
channels, it combines only channels; see page 171 in Chapter 5 for more info.

Variables
The Variables menu lets you designate areas of your document as placeholders for
other images or text that Photoshop adds automatically from a specified data
source (see the next item). This command lets you create powerful document templates that you can use to generate several versions of the same basic design (with
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different images and/or text) automatically. See this book’s Missing CD page at
www.missingmanuals.com for more about how this feature works.

Apply Data Set
Once you’ve created a document template containing variables, you can choose
this menu option to tell Photoshop where the variable data lives—the other images
and/or text—so it can automatically create the various versions of your document.

Trap
This command lets you set the spread of objects in your images, which controls
how much colors overlap where they intersect. This setting is important in offset
printing; you can learn more about printing your Photoshop images in Chapter 16.

Layer
This menu has controls for working with your document layers. From here you
can add and delete layers, create layer masks, and merge layers, among other
things. Chapter 3 has the lowdown on layers.

New
This command adds a layer or layer group to your image.

Duplicate Layer
This option does just what its name implies: Makes a copy of the current layer.

Delete
Choose this item when you want to delete a layer. You can also select a layer and
press the Delete key (Backspace on a PC). This is new in Photoshop CS4.

Layer Properties
This option lets you rename the current layer and assign it a color. It’s a handy way
to organize your ever-lengthening Layers panel (see page 69 in Chapter 3).

Layer Style
Go here to set the blending options for the current layer and to apply effects like
drop shadows, glows, and gradient overlays. Page 69 in Chapter 3 has more about
layer styles.

Smart Filter
This option lets you delete or disable a Smart Filter mask. Chapter 15 has the scoop
on using Smart Filters.
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New Fill Layer
Go here to create a layer and fill it with a solid color, transparent color, or gradient
(see page 69 in Chapter 3).

New Adjustment Layer
This option makes a new Adjustment layer so you can apply nondestructive
changes to your images. Adjustment layers are defined on page 69 in Chapter 3,
and they’re used throughout Part 2 of this book.

Layer Content Options
If you need to change an Adjustment layer’s settings, you can choose this command,
but it’s a lot faster to simply double-click the Adjustment layer in your Layers panel.

Layer Mask
From here you can show, hide, delete, and apply layer masks (page 69 in
Chapter 3).

Vector Mask
This option works much like Layer Mask item above, but it lets you work with vectorbased objects (page 494 in Chapter 13) instead.

Create Clipping Mask
This command converts a layer mask (page 69 in Chapter 3) into a clipping mask
(page 69 in Chapter 3).

Smart Objects
The Smart Objects option includes tools for working with Smart Objects—editing
them, duplicating them, and so on. See page 69 in Chapter 3 to learn about Smart
Objects.

Video Layers
This item lets you add, remove, and paint video layers (page 69 in Chapter 3). If
you have Photoshop CS4 Extended, you can also use this item’s options to restore
video frames, manage color, edit video and animation layers, and set when video
layers appear in a timeline.

Type
This option lets you convert text to a shape, warp text, and much more. Check out
Chapter 14 to learn about using text in your images.
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Rasterize
This command converts text, vector-based objects, Smart Objects, shapes, 3D
objects and video frames into raster-based objects. Chapter 2 explains the difference between raster and vector objects.

New Layer Based Slice
This item adds slices for Web layouts to the currently selected layer based on its
content; see Chapter 17 for details.

Group Layers
Use this command to group selected layers together. The layers will appear in their
own folder in the Layers panel (see page 69 in Chapter 3).

Ungroup Layers
This command removes layers from a group and deletes the group (but doesn’t
delete the layers).

Hide Layers
Use this command to hide layers or layer groups temporarily so you can see and
work with objects in complex images. See page 69 in Chapter 3 for more info.

Arrange
This item lets you change the order of layers and layer groups in your image.

Align
This option lets you align objects that are on different layers. Page 69 in Chapter 3
has the scoop.

Distribute
This item aligns the contents of three or more layers along the object’s edges or
center points (page 69 in Chapter 3).

Lock All Layers in Group
This command lets you lock selected layers in a particular group so you don’t accidentally edit or change them (page 69 in Chapter 3). If you select layers that aren’t
grouped, the menu item changes to “Lock Layers”.

Link Layers
Use this command to hook layers together so they move as if they were a single
layer. You can still edit linked layers, and you can unlink them, too (see page x).
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Select Linked Layers
Choose a linked layer and then use this menu item to select the layers linked to it.

Merge Layers
This command combines selected layers or layer groups into a single layer (page 69
in Chapter 3).

Merge Visible
Use this command to blend all your image’s visible layers into a single layer (page
69 in Chapter 3).

Flatten Image
This command merges all your image’s layers into the Background layer.

Matting
This option removes the extra pixels surrounding an object’s edge after you’ve
selected it and isolated it from another larger image. After you apply matting, the
item’s edge should look cleaner and more natural. See Chapter 4 for more on making and editing selections.

Select
The items in this menu let you grab layers, pick colors, use Quick Mask mode, and
more.

All
This command grabs everything on the current layer.

Deselect
Use this command to get rid of the marching ants around a selection (see
Chapter 4).

Reselect
If you didn’t mean to deselect a selection, use this command to get the selection
back.

Inverse
Choose this item if you select an area and want to flip-flop the selection to select
the part that’s not selected (page 124 in Chapter 4).
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All Layers
This option selects all the layers in your image so you don’t have to choose them
one at a time.

Deselect Layers
Choose this option to let go of all of the layers in your document.

Similar Layers
This item grabs all the layers in your document that are the same type, like Adjustment layers, Type layers, and so on.

Color Range
Use this feature to grab all of the areas in your image that are similar in color to the
current selection (see page 124 in Chapter 4).

Refine Edge
This command lets you fine-tune the edges of whatever you’ve selected (page 124
in Chapter 4).

Modify
This option lets you tweak the edge of your current selection by expanding or
shrinking it, feathering it, grabbing just its border, or smoothing it. Page 124 in
Chapter 4 has more info.

Grow
This command finds and grabs pixels that match the colors around the area you’ve
selected. (The pixels have to be adjacent to your selection—see page 124 in
Chapter 4.)

Similar
Like the Grow command, this option finds all the pixels in your image that match
the selected area’s colors, but it finds similar-colored pixels anywhere in your
image.

Transform Selection
This command lets you resize the currently selected area with the handles of a
bounding box (just like Free Transform). You can see it in action on page 124 in
Chapter 4.

Appendix D: Photoshop Menu by Menu

15

Filter

Edit in Quick Mask Mode
This option temporarily covers your image with a red overlay, or mask, letting you
create or fine-tune a selection visually (see page 124 in Chapter 4).

Load Selection
This command lets you activate a selection you previously saved so you can use it
again (see page 124 in Chapter 4).

Save Selection
Use this option to save your selection for future use (page 124 in Chapter 4).

Filter
This menu is packed with all kinds of effects you can apply to your images. It
groups filters by type: Artistic, Blur, Sharpen, and so on. Chapter 15 covers filters
in detail.

Last Filter
This command applies the last filter you used—with the same settings—to the current
layer or object.

Convert for Smart Filters
Use this feature to convert a regular layer to a Smart Object so you can use Smart
Filters (see page 587 in Chapter 15).

Filter Gallery
Choose this option to see a preview of how your image will look if you apply various filters. It’s available for several filter categories, and it’s a good way to learn
how those filters affect your image (see page 587 in Chapter 15).

Liquify
This filter lets you push, pull, and move pixels in all sorts of ways (page 391 in
Chapter 10).

Vanishing Point
This filter helps you maintain your image’s perspective while you paint, clone, or
add other images to your original image. See page 587 in Chapter 15 for the scoop.

Artistic
This category includes filters that make your images look like a painting or drawing
(page 587 in Chapter 15).
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Blur
These filters change the focus in all or part of an image (page 587 in Chapter 15).

Brush Strokes
The filters in this category make your image look like it was painted, penciled, or
spray painted, among other effects; see page 587 in Chapter 15 for details.

Distort
These filters create geometric patterns based on your image, including ripple, twirl,
and zigzag effects (page 587 in Chapter 15).

Noise
This category includes filters that can help smooth areas of your image that don’t
blend well, fix dust and scratches in photos, and remove graininess (page 587 in
Chapter 15). You can also use these filters to add grain to give your image more
texture and depth.

Pixelate
The Pixelate filters convert images or selections into groups of geometric shapes
and patterns (page 587 in Chapter 15).

Render
These filters let you add cloud patterns, fiber patterns, and lens flares, and adjust
your image’s lighting (page 587 in Chapter 15).

Sharpen
You can use filters in this category to make blurry or out-of-focus images appear
more clear (Chapter 11).

Sketch
These filters let you add artistic effects to make your images look like they were
hand drawn with charcoal, conté crayons, graphic pens, and so on (page 587 in
Chapter 15).

Stylize
The Stylize filters do things like turn your images into collections of blocks or dots,
or add a wind-blown look (page 587 in Chapter 15).
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Analysis (Photoshop
CS4 Extended Only)

Texture
These filters make your image look like it’s on a textured surface like tiles or
stained glass (page 587 in Chapter 15).

Video
These filters let you deinterlace (smooth) images that you’ve grabbed from videos
and restrict images to colors that display properly on televisions (NTSC-safe colors)
in the United States.

Other
This catch-all category includes options that let you build your own custom filters
and adjust the size of a layer mask, among other things. Page 587 in Chapter 15 has
more info.

Digimarc
These filters let you add a watermark and copyright information to your images
(see page 659 in Chapter 17).

Browse Filters Online
This option fires up your Web browser and takes you to the Adobe Web site where
you can browse and download even more filters.

Analysis (Photoshop CS4 Extended Only)
This menu appears only in Photoshop CS4 Extended. It includes tools for analyzing data in scientific images, counting objects, setting data points, and recording
measurements. Most folks don’t need these tools, but they’re really handy if you
work in scientific research or forensic analysis. One resource for learning more
about Photoshop’s analysis features is Photoshop CS3 Extended: Research Method
and Workflows available from Lynda.com.

Set Measurement Scale
Use this option to tell Photoshop what scale to use when it counts. The default is
one pixel equals one pixel, but you can change it to account for your image’s scale.
If, say, one micron in your image fills the space of 50 pixels, you can set Photoshop’s scale to match.

Select Data Points
Use this option to tell Photoshop what kind of info you want it to record when it
counts. The program records all the data types you select in the Measurement log.
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Record Measurements
Choose this command to see the Measurement Log panel where Photoshop displays all the data it collects from your image.

Ruler Tool
You can use this tool to measure items in your image (page 37 in Chapter 2). Click
and drag across an object and its measurements appear in the Options bar and
Info panel.

Count Tool
This tool helps you tally up the number of items in your image. You can click
objects to count them manually, or Photoshop can do its best to count them for
you.

Place Scale Marker
Use this tool to add a symbol to your image so people can tell what scale it’s in. Be
sure to set your measurement scale, as noted above, if you’re using the scale
marker.

3D (Photoshop CS4 Extended Only)
This menu is another Photoshop CS4 Extended–only feature (see the box on page
69 in Chapter 3). It includes tools for working with 3D images (like rendering and
painting on 3D objects). If you want to learn more about CS4’s new 3D capabilities, check out Chad Perkin’s Adobe Photoshop CS3 Extended for 3D and Video
(Adobe Press, 2007).

New Layer from 3D File
This option lets you open a 3D object as a new layer in your current document.

New 3D Postcard From Layer
Use this option to apply 2-D layers to 3D planes that Photoshop calls postcards.
Postcards can be used inside other 3D objects.

New Shape From Layer
This feature lets you wrap a 2-D image around a 3D shape. Photoshop CS4
Extended comes with a bunch of built-in shapes, including cones, spheres, donuts.

New Mesh From Grayscale
This option changes black-and-white images into surface maps for 3D objects.
Think of a surface map as a skin you can wrap around a 3D object.
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3D (Photoshop CS4
Extended Only)

New Volume From Layers
Choose this option to make a new 3D volume for 3D models. A volume is a shape
that represents part of a 3D object.

Render Settings
Go here to adjust what your 3D object’s surfaces will look like, what types of edges
it will have, its volume styles, and its stereo image settings.

Auto-Hide Layers For Performance
If Photoshop runs slowly when you work in 3D files, select this item to make the
program automatically hide layers you aren’t working with, which can help speed
things up.

Hide Nearest Surface
This command temporarily hides parts of surface models (the outer skin of a 3D
object) that are inside or touching the area you’ve selected so you can see deeper
into 3D shapes.

Only Hide Enclosed Polygons
This option works with the Hide Nearest Surface option to make Photoshop hide
only surfaces that are fully enclosed by the selected area on the 3D object.

Invert Visible Surfaces
Choose this option to hide the currently visible surfaces and show the hidden ones.

Reveal All Surfaces
Select this item to see all your 3D model’s surfaces.

3D Paint Mode
Use the items listed here to control how paint you’ve added to your 3D object
interacts with light.

Select Paintable Areas
Use this option to figure out which parts of your 3D object you can paint.

Create UV Overlays
This option lets you map points on 2-D texture maps to your 3D models for lighting effects. The points you map on the 2-D object line up with points on the 3D
object to make sure that the texture sits properly on the model.
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New Tiled Painting
This option lets you convert a 2-D image into a nine-square by nine-square tiled
painting that you can apply to 3D objects. It lies atop the object in a repeating grid
so that you can’t see the painting’s edges. (Tiled paintings can free up memory and
make your computer run faster when you’re working with 3D objects, since Photoshop has to load the grid only once and then apply it many times.)

Paint Falloff
Choose this option to set how much paint gets applied to curved surfaces that
bend away from your point of view.

Reparameterize
If you change the shape of a 3D object after you apply a texture to it, your texture
may look distorted. This option remaps the texture to remove surface buckles and
bends from a model that’s been modified.

Merge 3D Layers
Go here to blend two 3D layers so that both objects appear on a single layer. Both
objects remain editable, but if one is substantially larger than the other, the smaller
one may look like it’s embedded inside the bigger one.

Export 3D Layer
Use this option to make a new file that’s compatible with programs like Collada,
Wavefront/OBJ, and Google Earth or with the .u3d file format.

Render for Final Output
From here you can make a high-quality version of your 3D object that you can use
in animations, in print, or on the Web.

Rasterize
This option converts your 3D object to a flat, 2-D image.

Browse 3D Content Online
Choose this item to point your Web browser to the Adobe Web site where you can
download third-party add-ons designed to extend Photoshop’s 3D capabilities.

View
This menu gives you all sorts of different ways of looking at your images, from
zooming in or out to adding guides and rulers (see Chapter 2 for more documentviewing options).
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Proof Setup
Use the items in this submenu to create a proof (a sample version of your image
that simulates what the finished piece will look like). You can simulate how your
image’s colors will look on a Mac or a PC monitor or in another color mode—
even how a color-blind person would see them. This preview process, called soft
proofing, is discussed in more detail in Chapter 16.

Proof Colors
This option turns soft proofing on or off (see page 615 in Chapter 16).

Gamut Warning
Turn this feature on to make Photoshop highlight areas of your image that fall
outside of the safe color range, or gamut, for the color mode you’re working in.

Pixel Aspect Ratio
This item lets you change the shape of your image’s pixels for specific projects. See
page 37 in Chapter 2 to learn more about pixel shapes.

Pixel Aspect Ratio Correction
Turn this feature on when you’re working with pixels that aren’t square so your
images don’t look stretched when you view them on your computer monitor.

32-bit Preview Options
Because the dynamic range in 32-bit HDR images (see the box on page 341 in
Chapter 9) is greater than the color range most monitors can display, this option
compensates for washed-out highlights and overly dark shadows.

Zoom In
This command works like a magnifying glass, increasing your image’s magnification
level (see page 37 in Chapter 2).

Zoom Out
This command decreases your image’s magnification level.

Fit on Screen
This option resizes the current image and the window it’s in to fill your monitor’s
screen (see page 37 in Chapter 2).

Actual Pixels
Select this option to see your image at its actual size.
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Print Size
This item changes the size of your image to show how big or small it will be when
you print it. See Chapters 6 and 16 for more on resizing images for printing.

Screen Mode
This submenu lets you choose how you want to view your images. Page 11 in
Chapter 1 shows you your options.

Extras
With this option turned on, you can add alignment helpers like guides and grids to
your images. If you use one of these features, Photoshop will automatically turn on
Extras for you. Page 37 in Chapter 2 has the details.

Show
This submenu lists the extra items you can display and use while you’re editing
your images: guides, layer edges, notes, and more.

Rulers
This command shows or hides the horizontal and vertical rulers that run along the
document window’s left and top edges (see page 37 in Chapter 2).

Snap
Choose this item to turn snapping on or off. (Snapping lets you align objects with
guides and other items, as page 37 in Chapter 2 explains.)

Snap To
Here’s where you choose which items objects will snap to: guides, grids, layers,
slices, document bounds, or all of those things.

Lock Guides
This command prevents you from accidentally moving guides you’ve added to your
images. If you’ve already locked your guides, use this command to unlock them.

Clear Guides
Choose this option to get rid of all the guides you’ve added to the current document.

New Guide
This option lets you add vertical and horizontal guides to your image.

Lock Slices
Choose this item to keep slices (Chapter 17) where they are.
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Clear Slices
Removes all the slices from the current image.

Window
Use this menu to change what you see in Photoshop; it lets you arrange your open
documents, view or hide panels, and so on.

Arrange
This submenu has commands for organizing your open document windows. From
here, you can do things like open and close panels, set the same magnification level
across all your documents, minimize windows, and bring all your documents in
front of other windows.

Workspace
The items in this submenu rearrange Photoshop’s panels, menus, and tools to
make it easier to perform certain tasks like painting or working with text. Page 11
in Chapter 1 explains workspaces and why you may want to use them.

Extensions
Look here for a list of the Photoshop extensions installed on your machine, like the
new color-scheme generator, Kuler (page 449 in Chapter 12).

3D
Choose this item to make Photoshop display the 3D panel.
NOTE The 3D panel is included only with Photoshop CS4 Extended, so you won’t see this
menu item if you have the standard version of the program.

Actions
Choose this option to open the Actions panel, where you can see a list of the
actions that came with Photoshop, along with those you’ve created yourself. You
can also use this panel to manage your actions, as explained in Chapter 18.

Adjustments
New in Photoshop CS4, this panel lets you add Adjustment layers that you can use
to tweak your image’s color and lighting nondestructively. This panel is shown on
page 300 in Chapter 8, and it’s used throughout Part 2 of this book.

Animation
When you select this item, Photoshop displays the animation timeline and editing
panel. Check out page 659 in Chapter 17 for more on working with animations.
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Brushes
This panel lets you select and edit Photoshop’s built-in brushes, as well as brushes
you’ve created yourself. Chapter 12 teaches you more than you ever wanted to
know about the Brushes panel.

Channels
This panel shows the different color channels contained in your document. Check
out Chapter 5 for the skinny on channels.

Character
The Character panel is where you can find all sorts of settings for working with
text. See Chapter 14 to learn all about it.

Clone Source
This panel groups together settings for using the Clone tools (see page 254 in
Chapter 7).

Color
Use this panel to view and change your foreground and background colors (page 11
in Chapter 1).

Histogram
This panel includes a graph (called a histogram) that shows you information about
the pixels in your image. Turn to page 341 in Chapter 9 to learn how to read histograms.

History
The History panel displays a timeline of the edits you’ve made to the current document. This panel also shows what the image looked like last time you saved it and
lets you restore your image to any previous state. See page 11 in Chapter 1 for
details.

Info
This panel includes info about where your cursor is, the color of the pixels it’s hovering over, and the size of your current selection (if you have one). Page 11 in
Chapter 1 has more about this panel.

Layer Comps
Use this panel to view and organize groups of layers you can use to show different
versions of your image in a single document (see page 69 in Chapter 3).
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Layers
You can add, delete, and organize your document’s layers from this panel.
Chapter 3 is all about layers.

Masks
You can use this panel to add or edit a layer mask. It’s new in Photoshop CS4 and
it’s discussed on page 69 in Chapter 3.

Measurement Log
This is where you can see data collected by the Count tool. This panel is available
only in Photoshop CS4 Extended, so you won’t see it if you have the standard version of the program.

Navigator
This panel lets you change how much you’re zoomed in on your image and which
part of the image you’re viewing (see page 37 in Chapter 2).

Notes
You can view, edit, and delete notes from this panel (see “Move and Selection
Tools” in Appendix E).

Paragraph
This panel lets you control the paragraph-wide settings for text in your documents
(see page 530 in Chapter 14).

Paths
You can keep track of all the paths in your image using this panel. You can also use
it to change the stacking order of the paths as well as add and delete them. See
Chapter 13 for more on paths.

Styles
You can use this panel to apply Photoshop’s built-in styles to your images (page 69
in Chapter 3), as well as to create and save your own custom styles.

Swatches
Here’s where you can view and pick colors from libraries of color chips. Photoshop includes a long list of popular libraries including several Pantone, Toyo, and
Trumatch color groups.
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Tool Presets
If you regularly use the same settings with a particular tool, use this panel to save
them as a preset so you can use them again later. You can learn more about presets in Chapter 1.

Application Frame
Mac users can choose this item to turn Photoshop CS4’s new Application Frame
(page 11 in Chapter 1) on or off.

Application Bar
Mac users can show or hide Photoshop’s Application bar (page 11 in Chapter 1) by
selecting this item.
NOTE The Application Frame and Application bar menu items don’t appear in the Windows
version of Photoshop.

Options
This menu item shows or hides the Options bar (page 11 in Chapter 1).

Tools
Choose this option to show or hide the Tools panel (page 11 in Chapter 1). You’ll
work with this panel all the time, so you’ll probably want to leave it visible.

Open Documents
The bottom portion of the Window menu doesn’t actually have a label, but it’s where
Photoshop lists all the documents you have open (they’re listed alphabetically).

Help
If you don’t know how to do something in Photoshop, you may find the answer in
this menu. It includes a link to Adobe’s online help system, several tutorials, and
options for activating and deactivating your copy of Photoshop (see “Using the
Uninstaller” in Appendix A). You need an active Internet connection to use almost
every item in this menu.
NOTE In the Windows version of Photoshop CS4, this menu also includes the About Photoshop and About Plug-In items described in the box on page 711 in Chapter 19.

Photoshop Help
Here’s where you can access Photoshop’s online help system (see page 729 in
Appendix B), but you need an active Internet connection.
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Patent and Legal Notices
Yes, Adobe dedicated a menu item to Photoshop’s laundry list of patents and other
legal info. It’s fun reading if you’re into that kind of thing.

System Info
When you select this item, Photoshop generates a report that lists facts like which
OpenGL components your video card supports (page 37 in Chapter 2), which version of Photoshop you’re using, and which plug-ins you’ve installed.

Registration
Use this item to register your copy of Photoshop CS4 with Adobe (see “Checking
for Updates” in Appendix A).

Activate/Deactivate
The name of this item depends on whether you’ve activated your copy of Photoshop. If you haven’t, it’s called Activate; if you have, it’s Deactivate. “Checking for
Updates” in Appendix A has info about activating and deactivating Photoshop.

Updates
Choose this option to make Photoshop check for updates (see “Checking for
Updates” in Appendix A).

GPU
This item, whose name stands for “Graphic Processor Unit,” takes you to an Adobe
Web page with info about Photoshop, graphics cards, and OpenGL (page 37 in
Chapter 2).

Photoshop Online
Select this item to open your Web browser and head to Adobe’s main Photoshop
Web page. From here, you can visit the online Photoshop forums, hunt for addons like extra filters and actions, and check out other Adobe products.

How to Create Web Images
Choose one of the options listed here to see info about making rollovers, optimizing
images, and saving pictures to email.

How to Customize and Automate
This is where you can learn about automating tasks, making tool presets, and managing windows and panels.

How to Fix and Enhance Photos
These items show you how to improve your photos by cropping, making frames,
fixing red eye, and so on.
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How to Paint and Draw
This submenu includes tips on working with brushes, the Pen tool, and custom shapes.

How to Prepare Art for Other Applications
This item includes information about prepping a file for programs like Adobe
Acrobat and Adobe Illustrator.

How to Print Photos
Here’s where Adobe offers up its suggestions on printing images.

How to Work with 3D Images
This submenu gives you a taste of the cool stuff you can do with 3D objects in
Photoshop CS4 Extended.

How to Work with Color
Select this item to see Adobe’s how-tos on converting images to black and white
and replacing colors in your images.

How to Work with Layers and Selections
This submenu includes tips on aligning objects, working with Quick Masks, and
cutting objects from photos.

How to Work with Type
These type-related options have information about adding drop shadows to text,
changing fonts across layers, and filling type with images.
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